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AUCTION OF LICENSES FOR THE
700 MHz GUARD BANDS

UPDATED ATTACHMENTS AND FILING DEADLINES REMINDER

ADDITIONAL DUE DILIGENCE INFORMATION

Report No. AUC-00-33-E (Auction No. 33)

The Wireless Telecommunications Bureau (“Bureau”) issued a Public Notice that set forth the filing
requirements, minimum opening bids, and other procedural matters to govern Auction No. 33." Effective
Monday, July 17, 2000, the Bureau will permit the filing of FCC Forms 175 (“short-form applications™) via
the Internet. As a result, two of the attachments previously provided in the Auction No. 33 Announcing
Public Notice have been updated. Specifically, the Bureau has amended Attachment C and Attachment H.
Fully updated copies of those attachments are attached.

As a reminder, the filing deadlines associated with Auction No. 33 are listed below:
Opening of the FCC Form 175 Filing Window July 18, 2000; 12:00 noon ET

Filing Deadline for FCC Form 175 August 1, 2000; 6:00 PM ET

! See Auction of Licenses for the 700 MHz Guard Bands, Scheduled for June 14, 2000, Auction Notice and Filing

Requirements for 104 Licenses in the 700 MHz Guard Band, Minimum Opening Bids and Other Procedural Issues, Public Notice, DA
00-781, 15 FCC Rcd 6124 (rel. April 10, 2000) (“Auction No. 33 Announcing Public Notice™).


http://www.fcc.gov/

Upfront Payment Deadline August 18, 2000; 6:00 PM ET

Deadline For Remote Bidding Software Orders August 21, 2000; 6:00 PM ET
Mock Auction August 31, 2000
Auction Start Date September 6, 2000

Due Diligence Information

The Bureau also provides the following additional due diligence information to supplement the information
included in the Auction No. 33 Announcing Public Notice®. In addition to the filings listed in the Auction No.
33 Announcing Public Notice, potential bidders should also be aware of a Petition For Review of the 700
MHz Second Report and Order filed in the United States Court of Appeals for the District of Columbia
Circuit. The case is FreeSpace Communications, L.L.C. v. FCC, Case No. 00-1164 (D.C.Cir. filed April 18,
2000).

This information was compiled as of July 11, 2000 and supplements the list in the Auction No. 33 Announcing
Public Notice, which was compiled as of April 10, 2000. This list is subject to additional supplementation.
The Commission makes no representation that the April 10, 2000 compilation and the July 11, 2000
supplement include every proceeding pending as of July 11, 2000 relevant to the 700 MHz Guard Band
licenses or licensees. Potential bidders are strongly encouraged to conduct their own research prior to
Auction No. 33 in order to determine the existence of pending proceedings that might affect their decisions
regarding participation in the auction. Participants in Auction No. 33 are strongly encouraged to continue
such research during the auction.

For further information, contact Howard Davenport, Auctions Legal Branch at (202) 418-0660, or Linda
Sanderson, Auctions Operations at (717) 338-2888.

2 See Auction No. 33 Announcing Public Notice, 15 FCC Rcd at 6132-33.

3 Service Rules for the 746-764 and 776-794 MHz Bands, and Revisions to Part 27 of the Commission’s Rules, WT Docket
No. 99-168, Second Report and Order, 15 FCC Rcd 5299 (2000).



VIiIl. ATTACHMENT C

ELECTRONIC FILING AND REVIEW
OF THE FCC FORM 175

Applicants must submit their FCC Form 175 applications electronically, using either the FCC
Auctions System page on the Internet or the Commission's remote access system. The remote
access system will generally be available 24 hours per day. FCC Form 175 applications must be
submitted and confirmed by 6:00 p.m. ET on Tuesday, August 1, 2000. Late applications or
unconfirmed submissions of electronic data will not be accepted.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175. The electronic filing process consists of an initial filing period and a
resubmission period to make minor corrections. During each filing period, submitted
applications may be updated and amended multiple times until the filing deadline.

A. Minimum Hardware and Software Requirements

Applicants will need to meet the following minimum hardware and software requirements:

1. Minimum Hardware Requirements

o CPU: Intel Pentium

« RAM: 16 MB (more recommended if you have multiple applications open)

o Modem: 28.8 Kbps Hayes compatible modem or faster (recommend 56.6 Kbps)
« Monitor: VGA or above

» Mouse or other pointing device

2. Minimum Software Requirements

« Operating System: Microsoft Windows 95 or 98

» Web Browser: Netscape Communicator 4.73 is recommended. However, you can also use
Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note: To download Netscape Communicator 4.73 free of charge, access the Netscape
download site at http://home.netscape.com/download/

» PDF Viewer: Adobe Acrobat Reader 3.0 or higher (available at http://www.adobe.com)
« If you wish to use the download feature in the Form 175 Review, you will need a .tar file

extraction utility, e.g., Winzip (available at http://www.winzip.com) or Pkzip for Windows
(available at http://www.pkware.com/download.html).



B. Submitting FCC Form 175 Applications

You can submit FCC Form 175 applications electronically via the Internet. Start your Netscape
Web browser. In your browser’s Location field, enter http://wtbwww15.fcc.gov and then click
175 Submit.

Note: If you have problems with the Internet, you may submit FCC Form 175
applications via the FCC Wide-Area Network, using Dial-Up Networking. For details,
refer to the Accessing the FCC Network to File FCC Form 175 attachment.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of file
formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII text -
- and should verify that the files contain all exhibit information. Graphics file uploads (e.g.,
.bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics images
should not be imported into any word processing files that are uploaded. Do not upload a
password-protected file. The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly by
selecting the PDF filename in the rightmost column. The conversion process generally completes
within thirty minutes. If you are unable to read this file after it has been converted, please do the
following:

1. Re-upload the attachment.
2. If the file still has not converted properly, then simplify the formatting of the file.

For example, if you are using a Table structure in a WordPerfect document, remove the Table
structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175. Pressing Submit Form 175 produces a confirmation message showing the
assigned FCC Account Number. During each filing period, submitted applications may be
updated and amended multiple times until the filing deadline.

C. Reviewing FCC Form 175 Applications

Once the FCC has completed the 175 Review process, you can review FCC Form 175
applications electronically via the Internet. Start your Netscape Web browser. In your browser’s
Location field, enter http://wtbwww15.fcc.gov and then click 175 Review.



D. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from
8a.m.to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. All calls to the FCC Technical
Support Hotline are recorded.



X, ATTACHMENT H

ACCESSING THE FCC NETWORK
TO FILE FCC FORM 175

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 or Microsoft Windows 98 operating system. This involves configuring
dial-up network access and then performing the dial-up procedure.

Note: Dial-up access to the FCC Network is not required to submit or review FCC Form
175 applications. You can perform those functions from the Internet, by entering location
http://wtbwww15.fcc.gov/ on your Netscape Web browser and clicking the 175 Submit
or 175 Review button, respectively. For more details, refer to the Electronic Filing and
Review of the FCC Form 175 attachment.

Conventions
The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected
Licenses area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.
For example, if you are instructed to type http://wtbwww15.fcc.gov, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPs Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

A. Accessing the FCC Network to Submit FCC Form 175 Applications

The following section provides the instructions for configuring the dial-up network access in
preparation for submitting FCC Form 175 applications. The subsequent section gives the dial-up
procedure.

1. Configuring Dial-Up Networking

1. To start dial-up networking:



Click the Windows 95/98 Start button.

Click the Programs option to display the Programs menu.

Click the Accessories option to display the Accessories menu.

In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

oo o

If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95/98 CD or diskettes.

When the Dial-Up Networking window appears, double-click the Make New
Connection icon.

The Make New Connection window appears.

Type FCC Auctions 800# in the field titled Type a name for the computer you are
dialing.

In Windows 95, click the down arrow at the right of the Select a modem field and select
your modem from the menu of available modems.

In Windows 98, click the down arrow at the right of the Select a device field and select
your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according
to the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.

Click the Next button.

Type 800 and 378-7435 in the Area Code and Telephone Number fields, respectively.

If you need to dial 9 or some other digit to get an outside line, include that digit in the
Area Code field. For example, you might type 9, 1 800 in this field.

Verify that the correct country is selected in the Country code field.

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

Click the Next button.
Click the Finish button.

An icon labeled FCC Auctions 800# appears in the Dial-Up Networking window.



10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Verify that properties are configured correctly before attempting a dial-up session. Put
the mouse pointer on the icon and click the right mouse button to display a menu. Click
Properties from the menu.

Click the Configure button. Click the Options tab at the top of the Properties window.

In the Connection control area of the Options tab, verify that neither option is selected. If
either option is selected, click the check box at the left of the option to deselect it. Then
click OK.

In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

In the Advanced Options area, verify that only Enable software compression is selected.
If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

In the Allowed Network Protocols area, verify that only TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

Click the TCP/IP Settings button. On the TCP/IP Settings window, select Server
assigned IP addresses at the top and select Specify name server addresses midway down
the window.

Type 165.135.241.149 as the Primary DNS and 165.135.79.95 as the Secondary DNS.

Ensure that these two options are checked:

o Use IP header compression
« Use default gateway or remote network

Click OK on the TCP/IP Settings window and the Server Type window.
Close the Dial-Up Networking window.

a. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.



In a Windows 98 environment, a confirmation dialog appears. Read the information
on the dialog, then click the OK button.

d. Click the DNS Configuration tab and then click the Enable DNS radio button at the
top.

e. Type bidder in the Host box and type fcc.gov in the Domain box.

Note: You are limited to three DNS entries. If you already have three DNS entries,
you must delete two of them before performing the next two steps. To do this, click
the first entry you want to delete and click the Remove button. Then click the second
entry you want to delete and click the Remove button again.

f. Type 165.135.241.149 in the DNS Server Search Order box and click the Add button.
g. Type 165.135.79.95 in the DNS Server Search Order box and click Add again.

h. Click OK on the TCP/IP Properties windows, then click OK on the Network
windows.

If you are prompted to restart your computer, click Yes to restart, then begin
the Dial-Up Procedure.

2. Dial-Up Procedure

If the Dial-Up Networking window is not currently open, do the following:

Click the Windows 95/98 Start button.

Click the Programs option to display the Programs menu.

Click the Accessories option to display the Accessories menu.

In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

oo

The Dial-Up Networking window appears.
In the Dial-Up Networking window, double-click the FCC Auctions 800# icon.

Click the Connect button on the window. Do not enter User name or Password.

The Connection window appears, indicating the status of your connection as your modem
dials into the system. This window must remain running during your dial-up session. You
may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section.



B. Submitting FCC Form 175 Applications

After you have connected to the FCC Network, start your Netscape Web browser. In your
browser’s Location field, enter http://wtbwww15.fcc.gov (primary location) or
http://wtbwwwO04.fcc.gov (secondary location) and then click 175 Submit.

Note: The wtbwwwO04 location can only be accessed through dial-up networking; it
cannot be accessed through the Internet.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of file
formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII text -
- and should verify that the files contain all exhibit information. Graphics file uploads (e.g.,
.bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics images
should not be imported into any word processing files that are uploaded. Do not upload a
password-protected file. The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly
by selecting the PDF filename in the rightmost column. The conversion process generally
completes within thirty minutes. If you are unable to read this file after it has been converted,
please do the following:

1. Re-upload the attachment.
2. If the file still has not converted properly, then simplify the formatting of the file.

For example, if you are using a Table structure in a WordPerfect document, remove the Table
structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175. Pressing Submit Form 175 produces a confirmation message showing the
assigned FCC Account Number. During each filing period, submitted applications may be
updated and amended multiple times until the filing deadline.

When you have finished, exit your Web browser; then click the Disconnect button on the
Connection window to end your dial-up session.

C. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your
computer, as follows:



1. Click the Windows 95/98 Start button, then click the Settings option to display the Settings
menu.

2. Click Control Panel and then double-click the Network icon.

3. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP protocols,
highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears. Read the information on the
dialog, then click the OK button.

4. Click the DNS Configuration tab.

5. Click the DNS Server Search Order box containing 165.135.241.149 to select it, then click
the Remove button.

6. Similarly, click the DNS Server Search Order box containing 165.135.79.95 to select it, then
click the Remove button.

7. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.
8. If you are prompted to restart your computer, click Yes to restart.

9. Remove the FCC Auctions 800# icon from your desktop. That is, click the icon with your
right mouse button and then click the Delete option in the pull-down menu.

D. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

1. Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial-
tone.

3. Confirm that the correct modem driver is installed for your modem.

2. Modem dials but does not connect

1. Confirm that the number the modem is dialing is correct.



2. Confirm that the modem prefix, if any, is correct.

Using a Backup Dial-In Number. If the number and prefix are correct, the 800 number being
dialed may be experiencing problems. In this case, you can reconfigure the dial-up software
using an alternate dial-in number, which is also toll-free. To use the backup number, perform the
Configuring Dial-Up Networking procedure again, but this time make the following changes:

« In Step 3, type FCC Auctions 877# in the field titled Type a name for the computer you are
dialing.

o In Step 6, type 877 and 844-2788 in the Area Code and Telephone Number fields,
respectively.

e In Step 17, type 165.135.79.95 as the Primary DNS.

o In Step 20f, type 165.135.79.95 in the DNS Server Search Order box.

3. Modem dials and connects, but nothing appears when you enter the Location in the
Web browser

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up Networking
section.

2. Confirm that your Web browser is not using proxies:

a) On your browser, click the Preferences option in the Edit menu.
b) In the Category area at the left, double-click Advanced.

c) Click the Advanced structure’s Proxies option.

d) Click the radio button labeled Direct connection to the Internet.
e) Click the OK button at the bottom of the window.

4, Receive an Internal Server error in the Web browser

1. Confirm that the Location is set to http://wtbwww15.fcc.gov or http://wtbwwwO04.fcc.gov

2. On your browser, click the Preferences option in the Edit menu. In the Category area at the
left, double-click Advanced. In the area at the top, confirm that Enable Java and Enable
JavaScript are selected. In the Cookies area, confirm that Accept all cookies is selected.



E. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from
8a.m.to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET. All calls to the FCC Technical
Support Hotline are recorded.
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